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1. Introduction to System Manager    

Inova LightLink® System Manager™ is a Supervisor application in the Inova 
LightLink System.  System Manager provides the following general areas of 
functionality: 

• Viewing status of all messages sent to LightLink LED displays, Inova 
Marquee displays, and other output devices configured in the Inova 
LightLink System   

• Managing virtual displays, which are regions within a configured display 
to which messages can be sent independently 

• Creating and modifying display groups, which are logical groupings of 
output devices and/or virtual displays, to which messages can be sent as a 
group 

• Managing messages that are currently active or scheduled on output 
devices  

• Viewing message properties and status 

• Manually deactivating, returning to schedule, and cancelling messages 

• Reviewing and modifying message content, destination, and schedule via 
Message Editor, and the Fast Text editor 

• Sorting and filtering the message display 

• Launching the Log Viewer to examine diagnostic output for LightLink 
programs  

LightLink supports English across the entire platform.  Support for other character sets is 
provided in Fast Text messages sent to TaskLink clients and their message titles as shown 
in System Manager status panes. 

1.1. Accessing System Manager 

System Manager can be accessed using any of these methods: 

• Start > All Programs > Inova Solutions > Supervisor Applications > System 
Manager 

• LightLink Administrator > Tools menu > System Manager 

• LightLink Administrator > Toolbar > System Manager    icon 

• Inova Quick Launch > System Manager 
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Note: System Manager can be started via LightLink Administrator only when both 
applications are installed on the same host computer. 

When LightLink security is active, the user account launching the System Manager 
application will be validated against the user list of the LightLink Security Groups. 
If the user account is not in one of the Inova LightLink Security Groups, or if 
present but disallowed from running System Manager, the System Manager 
application will display a message to that effect and will shut down. When 
LightLink security is dormant, this check will not be made.  

1.2. System Manager Panes 

Once System Manager is open, you will see the System Manager screen (Figure 1).  
System Manager consists of four panes.  The dividers between these panes may be 
dragged to adjust the size of each. 

• Output Device Tree – shows all the displays or groups where your 
messages are being sent. 

• Overall Status Pane - displays those messages sent to the destination that is 
selected in the Output Device Tree.   

• Detailed Status Pane – displays information about the message selected in 
the Overall Status Pane.   

• Fast Text Message Editor – The bottom right pane of the window shows 
the Fast Text message editor.  Note that you can show or hide the Fast Text pane 
using the View menu in the toolbar. 

Refer to the following sections for more detailed information about the Output 
Device Tree, Overall Status, and Detailed Status panes.  For more information 
about Fast Text messaging, refer to the section Using Fast Text Messages on page 
16.   
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Figure 1 

1.3. Output Device Tree Pane 

The Output Device Tree allows you to specify the set of displays for which to 
show messages. These output devices are organized by logical, user-defined 
output device groups and by physical device connection.  

When you select a channel, display, system root node or the display groups node, 
all visible active messages on those displays appear in the Overall Status pane. An 
Active message is one which has at least one currently playing message instance 
on a display. The availability of the message options is according to your access 
rights. 

Once all occurrences of a message are expired or cancelled that message is 
relegated to the Cancelled/Expired node (trashcan).  

The Output Device Tree is a hierarchy organized into three root nodes:    

• System node - Selecting the System root node causes all visible messages in 
the system to be displayed in the Overall Status pane.  

• Display groups node - Selecting the display groups root node causes all 
visible messages with a display group in its destination to be displayed in 
the Overall Status pane.  

• Cancelled/Expired node (trashcan) - Selecting the Cancelled/Expired 
(trashcan) item will cause messages where all instances are cancelled or 
expired to appear in the Overall Status pane.  

Each item in the tree shows a red ‘X’ over the icon if there is a connection problem. 
A channel will display a small red square over its icon if it is disabled.   The 
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following details what messages you can expect to see in the Overall Status pane 
when the various tree items are selected: 

• Selecting a channel will show all messages sent to the channel, a display on 
that channel or a virtual display on that channel 

• Selecting a display will show messages sent to that display and messages 
sent to any virtual display defined for it 

• Selecting a virtual display will show only messages sent to that virtual 
display 

• Selecting a display group will show messages sent to the display group, 
any display in that display group, or to any virtual on any display in the 
display group 

• Selecting multiple items in the tree will show all visible messages that meet 
the criteria you selected 
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1.3.1. Output Device Tree Icons 

Refer to Figure 2 for the icons that may appear in the System Manager device tree.   

 Icon Description 

Top Level 
Nodes 

 

System root node 

Output 
Device 
Connection 
Node 

 

Online Output Channel 

  
Offline Output Channel 

 

Disabled Output Channel 

Output 
Devices 

 

Online display 

 

Offline display 

Figure 2 

1.4. Overall Status Pane 

Inova LightLink System Manager provides the Overall Status pane to display 
overall status for messages playing on destinations selected in the Output Device 
Tree. Overall Status can be an OK, Error, Disabled, or Unknown status icon for 
each message.  

The Overall Status pane is a list with several columns that can be shown or hidden 
as needed. These columns can also be dragged around to change their display 
order. Each column has a filter option in its header that allows the user to show 
only those items that contain a certain text value; the filter option is a text entry 
box indicated by the funnel icon. The columns may be sorted in the usual fashion 
by clicking the column header to toggle in ascending or descending sort order.  

The bottom of the Overall Status pane has: 

• An informational text field at the left. 

• An error status count field. 

• A bad status (Disabled) count field. 

• Content type filter buttons (Messages, Views, Fast Text). 

• A Clear Fields button to clear all filter fields.  

• A Columns button to select columns to show in the Overall Status pane. 
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You can select one or more messages within the display using the conventional 
Windows select/multi-select methods (shift-click, control-click). When a message 
is selected, its information appears in the Detailed Status pane below. Multiple 
messages may be selected and operated on simultaneously. 

 

Figure 3 

The Overall Status pane displays the messages playing on the displays 
represented by the tree selection. When active messages are being shown, each 
message will have an icon next to it summarizing the status of that message (i.e., Is 
this message playing as it should?).    

• If the message is not playing as expected due to a system problem, an error 
icon appears next to it.  

• If the message is playing as expected, then an OK icon appears next to it.  

• If the message is not playing as expected but is doing so due to a 
configuration setting (such as an OCM being disabled) a Disabled icon will 
appear next to it.  
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• If a message status has not been reported by an OCM, an 
Unknown icon appears next to it. In the case of Error and 
Disabled conditions, a detailed status field contains information pertaining 
to the message status.  

An error condition may be due to Display Offline, OCM offline, OM not running, 
or launcher on hostname not responding. A Disabled condition is only triggered 
by a disabled OCM. If the Cancelled/Expired node is selected then only fully 
cancelled and expired messages are shown. The icon next to each message in the 
Canceled/Expired list will show whether the message was cancelled or if it 
expired on its own. 

1.4.1. Columns Button for Overall Status Pane 

The Columns button is located at the bottom right of the Overall Status pane.  The 
Columns button allows the selection of which columns to show in the message list. 
A check appears next to each column that is currently visible (see Figure 4). 

Refer to Figure 5 for descriptions of the Overall Status Columns options: 

 

Figure 5 

Figure 4 
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1.5. Detailed Status Pane  

System Manager uses the Detailed Status pane to display detailed status 
information for messages selected in the Overall Status pane. The Detailed Status 
pane consists of a list with several columns that can be shown or hidden as 
needed.  

You may select one or more 
messages within the pane 
using the conventional 
windows select/multi-select 
methods. When an entry is 
selected, activation and 
cancellation operations are 
available that operate only on 
the displays associated with 
the selections. Multiple 
message instances may be 
selected and operated on 
simultaneously. 

 

Figure 6 
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The Detailed Status pane shows the detailed status of the messages selected in the 
Overall Status pane for each display to 
which the message as sent. If the message 
status mismatches, the status detail 
column will show status mismatch. If an 
OCM is offline, the details column shows 
OCM offline. If the display is offline is 
shows Display Offline. 

When active messages are being displayed 
the context menu allows messages to be 
cancelled, deactivated, and returned to 
schedule on individual or multiple 
displays. If there are ended messages 
shown, there will be no context menu for 
them. Nor will there be a context menu if 
a multiple selection is made including any 
ended messages. 

Changing the selected messages in the 
Overall Status pane changes what is 
shown in the detailed status pane. 
Operations are allowed from this pane to 
change the expected status for a message 
on an individual display.  

If a message has a cancelled or expired 
component in the system, it will appear in 
the Detailed Status pane when selected in 
the Overall Status pane.  Refer to Figure 7 
for descriptions of the icons from the Detailed Status.  

1.5.1. Columns Button for Detailed Status Pane 

 The Columns button allows the selection of which columns to show in the 
message list. A check appears next to each column that is currently visible.   

The columns for System Manager can also be dragged to change their display 
order. Each column has a filter field in its header that allows the user to show only 
those items that contain a certain text value.  

The columns may be sorted in the usual fashion by clicking the column header to 
toggle in ascending or descending sort order. The bottom of the Detailed Status 
pane has an informational text field, a filter mode field, a button to clear all filter 
fields and a button to select list columns.  

 

Figure 7 
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The Status Match column shows OK if the expected and actual 
statuses are compatible states. If the actual and expected statuses 
are no compatible, then Error is shown. If the actual status is 
unknown and the detailed status is non-empty, an Error is shown. 
If the actual status is unknown and the detailed status is empty, 
an Unknown icon is shown. 

The Columns button allows the selection of which columns to 
show in the message list. A check appears next to each column 
that is currently visible.  

Clicking Clear Filters will clear any text you entered in the filter boxes in the 
header above each column in the message list. 

In addition to the icons in Figure 7, you will also see the following items: 

 

Figure 9 

1.6. Determining the Properties of a Display 

To view the properties for an output device, select the device and click on the 
Properties icon in the Toolbar or right-click on the device and select Properties from 
the context menu. The Properties for Display dialog appears.  This is a read-only 
dialog.  The Properties dialog displays helpful information about your display:   

• ID - The unique server/connection/display address for this item 

• Serial - Shows the serial number of a serial display, the name of a TCP/IP 
display, or the device name of a desktop client. 

• Type - The type of output device 

• Dimensions - The height and width of the item 

• Color - Color (red/yellow/green) or Monochrome 

• Version - The current version of Inova LightLink firmware under which 
this item is running 

• Status - The status (CONNECTED, UNKNOWN, or ERROR) of the device 

• Network Address - Shows the IP address of Marquee clients and TCP/IP 
displays  

• User Name – the name of the logged in user for a desktop client   

 

Figure 8 
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2. Access Rights for System Manager 

Access Rights define what channels and display groups each user is permitted to 
view. Each user's Access Rights also implicitly define what messages that user can 
view in System Manager. Access Rights are assigned using the Security Manager 
application. 

System Manager will show all messages sent directly to displays that are members 
of display groups and channels you do have access to, but messages sent to a 
channel or to a display group you do not have access to will be hidden from view. 
System Manager filters out messages sent to groups and channels you do not have 
access to and these will also be hidden from viewing.  

Access to messages on a display is implicitly defined by the channels and display 
groups to which you have access. If you have access to a display group with a 
display in it, then you will have access to the messages sent to that display via the 
display group, those sent to that display via a channel to which you have access, 
and those sent directly to the display.  

In cases where messages are sent to multiple groups or channels where you have 
partial access rights, you will see the messages under the components where you 
have access rights. If any part of a message destination matches your access rights, 
the message will be visible.  
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3. Working with LightLink Messages  

System Manager allows you to monitor and modify messages that were created in 
Message Editor.  

3.1. Opening a Message  

To open a message, double click on the message or select Open from the message 
context menu in the Overall Status pane. 

3.2. Creating a New Message 

To open Message Editor to create a new message, select File > New. 

System Manager opens the application that corresponds to the type of displays currently 
selected in the output device side. 

3.3. Cancelling a Message 

Cancelling the message in System Manager deletes it from the system.  Refer to 
Section 3.5 for details about deactivating a message, which stops the message from playing 
but does not remove it from the system. 

To cancel a message, you can use the context menu for that message or the 
Message menu in System Manager.  From the menu, select Cancel and then either 
on all locations or on selected locations (Figure 10).   

 

Figure 10 

To View the Canceled and Expired messages in your system, select the 
Cancelled/Expired node. 
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When ended messages are being displayed the context menu has a different set of 
operations. This menu allows you to remove ended messages from the Data 
Directory completely or open them in Message Editor for resending.  

• Open - Allows you to view the selected expired message. 

• Remove - Allows you to permanently remove a message from the trashcan. 
This menu item is enabled when the trashcan is being viewed.  

• Properties - Allows you to view the properties for the message.    

3.4. Returning a Message to its Schedule 

You have the option for the selected message to return to its original schedule.  To 
do so: 

1. Select Return to schedule from the context menu for the desired message(s). 

2. Select on all locations or on selected locations.   

Returning to schedule does not apply to canceled or expired messages. 

3.5. Deactivating a Scheduled Message 

Deactivation does not apply to canceled or expired messages. 

To deactivate a message: 

1. Select Deactivate from the context menu for the desired message(s). 

2. Select on all locations or on selected locations.    

3.6. Adding a Message to Selected Devices 

Once you have created a new message, you can add that message to other selected 
devices.  To do so: 

1. Select Open from the context menu for the message. 

2. Modify the message as desired. 

3. Select the icon to choose the message destination (Figure 11). 
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Figure 11 

4. The Select Destinations dialog opens.  Select desired devices on the left and 
click the Add button. 

5. Click OK to save changes.   

Removing devices in the Add/Remove dialog does not remove the original message from 
the original destination; it only removes that device from future updates to the message.  
To completely remove the message from the display, you will either need to cancel 
or deactivate the message for that display.  Refer to Section 3.3 (to cancel) or 
Section 3.5 (to deactivate). 

3.7. Message Properties 

The Message Properties Dialog is a pop-up dialog that displays the overview for a 
single message. The Message Properties can be launched from the System 
Manager main menu or from the Overall Status pane.    

1. Open the context menu for the desired message.  

2. Select Properties.  The Message Properties screen appears with the following 
fields:  

• Title – The title of the message, identical to the Message column in the main 
System Manager window 

• ID – The unique Activity ID of the message  

• Type – The content type of the message.  For 5.7 and beyond the supported 
content types are LightLink Message and Fast Text Message 

• Destination – The Destination description for the message, identical to the 
Destination column in the main System Manager window 

• Schedule – The Schedule description for the message, identical to the 
Schedule column in the main System Manager window 

• Sent – The Date, Time, and user who sent the message 
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• Category – The Categories in effect for the message; this is an optional 
setting only available for specific installations. 

None of the items on this dialog may be edited.   

3. Select OK to close this dialog.   

3.8. Migrating Messages 

Mechanisms for the import and export of messages and views and the migration 
of DataLink files are provided by System Manager and are accessed via the Tools 
menu in System Manager. These features are used for moving messages from one 
LightLink system to another and matching data field names with data field IDs in 
the LightLink system to which the messages are being moved. Refer to the 
LightLink Migration Tool Solution Guide for more details on Import, Export, and 
Migrate LLD. 

There are two settings that must be made for the Message Migration options to 
show in the Tools menu for any particular user.  To allow migration options for a 
user of System Manager: 

1. Ensure that the user is a member of a LightLink Security Group (refer to the 
LightLink Security Manager User Guide). 

2. Open Security Manager and select the desired LightLink Security Group in 
the LightLink Security Accounts pane.   

3. Click the Configure button. 

4. On the Default Profiles tab, select System Manager in the application pull-
down menu. 

5. Set the Show Migration property to 1. 

6. Enable Force profile settings on all group members. 

7. On the Privileges tab, open the System Manager node and ensure the Import 
and Export messages privilege is enabled.  
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4. Using Fast Text Messages 

4.1. Fast Text Overview 

Fast Text allows users to send spontaneous messages or notifications to LightLink 
displays.  A Fast Text message can be sent to multiple TaskLink clients XML 
outputs (simple messaging only), or email destinations.  Each Fast Text message 
will play until it is replaced or cancelled.  Fast Text messages are composed and 
sent using the Fast Text editor at the bottom of the System Manager window (see 
Figure 12). A message composed in the Fast Text editor will be sent to the 
destinations selected in the LightLink device tree at the left. Fast Text messages sent 
to TaskLink clients can include English and other character sets; only English characters 
are supported at other destinations. 

 

Figure 12 

4.2. Required LightLink Components 

To use the Fast Text feature, the LightLink system must have these three 
components installed (see Figure 2). 

• Fast Text capable display client, including any of the following:  

• Inova Solutions TaskLink – this application can be of any recent release 
version from 5.5 or later. 

• Email Address Virtual Display – requires LightLink Middleware version 
5.6 or 5.7 or later. 

• XML output device – set up for Simple Messaging XML output. 

• Inova Solutions Supervisor Applications – the System Manager 
application is required to send and manage Fast Text messages (latest 
release required). 
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• Inova Solutions Middleware – this is a required component to any 
LightLink installation (prior 5.6 or 5.7 versions are sufficient). 

4.3. Fast Text Behavior 

Fast Text messages are minimally-formatted text messages without any schedule. 
They are created in the System Manager application using the built-in Fast Text 
message editor.  Fast Text messages will play upon their receipt by the destination 
client and will end only when cancelled or replaced by a new Fast Text message.  

Only one Fast Text message can be playing on a device at a time. This means that a 
Fast Text sent to a device will be replaced if another is sent to that same device.  
Fast Text messages can be sent to one or more displays directly and can be sent to 
one or more display groups or output channels. There can be any number of Fast 
Text messages in the system at a time, but only one will play per display.  

Most of the message operations available to other types of LightLink messages 
(i.e., deactivate, return to schedule) are not applicable to Fast Text messages. The 
user can only cancel or replace Fast Text messages. When all instances of a given 
Fast Text are replaced or cancelled, the message will show up in System 
Manager’s Cancelled/Expired bin (Trash Can) like any other deleted or finished 
message. 

4.4. Valid Destinations 

The following are valid destinations for Fast Text messages: 

• TaskLink devices 

• Email devices (must be individually selected) - email address Virtual 
displays can be the destinations of Fast Text messages; the 'Email OCM' and 
'To: Address' tree nodes are not supported as destinations. 

• XML destinations – set up for Simple Messaging XML output. 

• Display groups with at least one device that supports Fast Text. Message 
resolution does occur for Fast Text messages sent to a display group so a 
device that is added to the display group after the Fast Text message was 
sent will receive that Fast Text message. 

4.5. Sending a Fast Text Message 

To send a Fast Text message: 

1. Enter the message text in the editor.  (See Figure 13.) 
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Figure 13 

Fast Text messages can include English and other character sets when sent to 
TaskLink clients; only English characters are supported at other destinations. 

2. Set the attributes as desired.  Each of the message attributes applies to the 
entire message.  These attributes are: 

• font name 

• font color 

• background color 

• font appearance (i.e., bold and italics) 

Note that default settings for these attributes can be specified using the 
Default Profiles setting in Security Manager, and the last used settings will 
be retained for the next message.  

TaskLink devices will only use their own presentation settings when 
displaying a Fast Text message. When a Fast Text message is sent to an 
email device, just the text of the message will be sent without any 
formatting information.  

3. In the device tree on the left, select the destinations where the Fast Text 
message should be displayed.  The 'Send' button will be enabled when at 
least one device in the current destination selection supports Fast Text.   

If a Fast Text destination includes a device that doesn't support Fast Text, 
that device is skipped, no message is sent to that particular device, and no 
error indicator is generated. 

4. Click the Send button to have the message displayed on the selected 
destinations.  The “Send” button will be enabled if at least one device in the 
current destination selection supports Fast Text.  If a Fast Text destination 
includes a device that doesn't support Fast Text, that device is skipped and 
that no message is sent to that particular device but also no errors are 
indicated either. 

Fast Text messages are not subject to automatic message resolution if sent to a 
channel and a device is later added to that channel. A Fast Text message with an 
output channel as its destination will only be sent to the devices currently present 
on the channel (but not necessarily currently logged in); new devices added to the 
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channel will not receive Fast Text messages automatically. To ensure any new 
additions to the channel display the message, the user will have to select the 
message in System Manager, select the channel and re-send the message. 

For information about how to check on the status of a message, refer to the “Overall Status 
Pane” section on page 5 of this manual. 

4.6. Resending Messages 

To resend a message, select an existing Fast Text message in the Overall Status 
pane of the System Manager window to populate the Fast Text editor with the text 
and attributes of the message.   

This allows you to send the same message content to additional destinations or to 
modify it and send it to the same or different destinations.   

Selecting an existing message does not select the original destinations; the currently 
selected destinations in System Manager’s Device Tree remain selected as the Fast Text 
destination. 

Selecting another destination in the Output Device Tree will not change the 
attributes or text of the message in the Fast Text editor.  Changing the message 
selection in the ‘Overall Status’ pane clears the attributes to default settings if no 
message or a non-Fast Text message is selected.  Selecting another Fast Text 
message will discard any changes made in the Fast Text editor and will replace the 
text and attributes with those of the newly selected Fast Text message. 

4.7. Cancelling Messages 

To cancel a Fast Text message: 

1. Select it in the Overall Status pane of the System Manager window and 
right-click to bring up the context menu.  

2. Select the Cancel operation and the message will be cancelled on the 
currently selected destinations.   

To cancel a Fast Text message entirely on all destinations to which it was sent: 

1. Select all of the message destinations in the LightLink device tree to the left.   

• To select all the destinations for a Fast Text message, select all the channels 
and display groups containing displays to which the message was sent or 
select the top-most node of the Output Device Tree.   

2. Cancel the message using the context menu in the Overall Status pane of 
the System Manager window. 



LightLink System Manager 
User Guide 

 

All claims and information in this document are based on information publicly available at time of printing.  
All other product or service names mentioned in this document may be trademarks of the companies with which they are associated.  

© 2021 Inova Solutions  |  All rights reserved  |  page 20 

5. Display Groups 

Display groups are used to combine separate display devices into a group so one 
message can be sent to multiple displays. 

For example, let’s say you want to send the same message to all 10 devices on the 
first floor.  In System Manager you create a display group called First Floor.  Then 
when the message is created in Message Editor or Designer, the user can select the 
First Floor display group as the destination. 

5.1. Creating a Display Group 

The following details how to create a display group. 

1. Select System Manager > Display > Display Group > New. 

2. Select a display or device on the left and click Add to add it to the display 
group. 

3. Continue adding displays and devices until the desired display group is 
complete. 

4. Enter a name for the new display group.   

5. Select OK.   

Display groups cannot contain other display groups or Output Channels.  

5.2. Adding or Removing Displays from a Display Group 

The following details how to add or remove displays from a display group in 
System Manager.   

• You can use System Manager to exclude displays from your display groups 
or add existing displays to a newly-created display group. 

• You cannot physically remove a display from the Inova Solutions LightLink 
System using System Manager. You must work through the Inova Solutions 
LightLink Administrator to remove a display or other types of output 
devices from the LightLink system. 

Below are the steps to adding or removing displays from the display group.   

1. From the Output Device tree on the System Manager main screen, select the 
display group you want to modify. 

2. Right-click to open the context menu; choose Display Group > Modify. 

3. The Select Display Group Members dialog appears.     
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• To add a display, select an item you want to add in the left-hand pane and 
click the Add button. Note that channel items cannot be added to display 
groups, only their members can be added.  

• To remove a display, select an item you want to remove in the right-hand 
pane and click the Remove button. 

4. Click the OK button to accept the changes you made and close the Display 
Group Members dialog. 

5.3. Deleting a Display Group 

The following details how to delete a display group. 

1. Select the display group you want to delete. 

2. Right-click to open the context menu; choose Display > Display Group > 
Delete. 

3. Select Yes to delete the selected display group or select No to stop this 
process and return to the previous screen. 

It is not possible to delete an actual display from System Manager. This must be carried 
out from the Inova LightLink Administrator main screen. 

5.4. Renaming a Display Group 

To rename a display group: 

1. From the Output Device Tree, select the display group you want to rename. 

2. Open the context menu; choose Display Group > Rename. 

3. Type the new display group name. 

When you have entered the new name, hit Enter or click somewhere else on the 
screen. 
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6. Virtual Display Overview 

LightLink virtual displays allow you to divide a single display into different 
grids.  In effect, each grid can then be treated as a separate, or virtual, display.  For 
example, using virtual displays, you can: 

• Send messages to individual lines or regions of a display 

• Send the same information to the top line of one Display and the bottom 
line of another 

• Create a system clock on any Inova display or Marquee 

• Display real-time statistics AND an ad-hoc message on the same Inova 
OnTrack display or Marquee 

• Use Security Manager to secure certain regions of displays so that other 
users cannot make changes 

6.1. Dividing a Display 

To use virtual displays, you must first understand how the coordinates of the 
display are mapped.  It is helpful to think of the display as a grid.  The first 
coordinate indicates the top-to-bottom location; the second coordinate reflects the 
left-to-right location.  Note the coordinates indicated in Figure 14 for a 48x256 
display that is divided into four rows.  Note that the height and width coordinates 
will vary depending on the size of your display. 

 

Figure 14 

As an example, Figure 14 has four virtual displays:  clock, header row, data lines 1 
and 2, and message region. 
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6.2. Creating a Virtual Display 

To create a virtual display in System Manager: 

1. From the Output Device Tree, open the context menu for an output device 
such as an OnTrack display or a Marquee client for the virtual display. 

2. Choose Virtual Displays > Define.  The Edit Virtual Displays dialog opens.     

3. Select a type from the Type drop-down.  The available options will depend 
on what types of devices you selected initially.   

4. Enter a name for the layout.  Once you have created and named a layout, 
you can reuse that setup for other displays.   

5. Select Add to add a virtual display to this layout.   

6. The New Virtual Display dialog appears.  Within this dialog you define the 
name and dimensions of the virtual display.  

a. Enter the name for the virtual display.  

b. Enter values for the Left, Top, Width, and Height coordinates.  For 
example, in Figure 14, the values for the virtual displays would be as 
seen in Table 1.  

c. Select OK. 

 
Left Top Width Height 

 Value of left-
most point of 

the virtual 
display 

Value of the 
top point of 
the virtual 

display 

Total width of 
the virtual 

display 

Total height 
of the virtual 

display 

Clock 0 0 100 12 

Header 100 0 156 12 

Data Line 1 0 12 256 12 

Data Line 2 0 24 256 12 

Message Region 0 36 256 12 
Table 1 

7. Repeat steps 5 and 6 to create additional virtual displays on the selected 
output device 

8. Select OK to accept your configuration changes.  
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6.3. Modifying a Virtual Display 

The following details how to modify a virtual display in System Manager. 

1. Select the virtual display to be modified. 

2. Select Display > Virtual Displays > Define.  The Edit Virtual Display dialog 
appears. 

3. If you wish to use a layout you have already created, select the desired 
layout from the drop-down menu.  

4. To modify part of the existing display, select the part you want to modify.   

5. Select Edit and make desired changes to the name and values.  Click OK.   

6. Click OK to accept your configuration changes.  

Note that any changes to a layout are not automatically propagated to other 
displays that use the same layout. 

6.4. Deleting a Virtual Display 

The following details how to delete a virtual display in System Manager. 

1. Select the virtual display to be deleted. 

2. Choose Virtual Displays > Delete.   

The virtual display is deleted. 
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7. System Manager Menu Commands 

System Manager operations are available via Menus in the menu bar, context 
menus available by clicking the right button of the mouse, and keyboard shortcuts 
(shown as underlined letters when menu options are displayed). 

7.1. Context Menus 

All items in System Manager have context menus; the context menus open when 
you click the right button of the mouse.  The context menu options vary based on 
what is currently selected when right-clicking.  For example, right-clicking over a 
message brings up the menu options applicable to that message, and when right-
clicking on an empty space in the status pane the context menu has only the 
"New" menu option. If multiple items are selected when right-clicking, the context 
menu will display the intersection of available menu options applicable to those 
items.   

7.2. Message Commands for System Manager 

The following describes the message commands for System Manager.  These 
commands are available through the Message menu in the tool bar and through 
the context menus in the Overall Status and the Detailed Status panes.  If you do 
not have rights to for the selected messages or devices then these choices will be 
grayed out. 

• New - Starts the Message Editor with a blank message to allow the creation 
of a new message.     

• Open - Opens Message Editor with the selected message displayed in the 
Editing Window, ready to edit.  In Message Editor, when you send this 
message, you can either replace the existing message or send it as a new 
message, which leaves the existing message as it is.  

• Remove – Removes the message. This option is only available for expired 
or cancelled messages in the Cancelled/Expired node. 

• Deactivate > on all locations - Causes the selected message to stop playing 
on all locations to which it was sent.   

• Deactivate > on selected locations - Causes the selected message to stop 
playing as scheduled.   

• Return to Schedule > on all locations - Causes the selected message to 
return its schedule at all locations at which it is currently deactivated.   
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• Return to Schedule > on selected locations - Causes the selected message 
to return its schedule at the selected locations.   

• Cancel on all locations - Cancels the selected message(s) on all locations to 
which the message is currently sent.   

• Cancel on selected locations - Cancels the selected message(s) on the 
currently selected locations.   

• Properties - Opens the Properties dialog to determine the status of the 
message at each display to which it was addressed, the content of the 
selected message as well as its destination, schedule, date, time, and 
sender.  If no message is selected or more than one message is selected, then 
this option is disabled. 

• Exit - Exits System Manager (not available on the context menu). 

7.3. Display Commands   

These display commands are available through the Display menu and through the 
context menus in the Output Device Tree.  Only Display Group > New is enabled 
when the Cancelled/Expired node is selected. 

• New Message - Opens Message Editor to create a new message using the 
selected device as the default destination.  (This menu item is available only 
through the context menu.) 

• Copy Virtuals and Groups – Opens the destination dialog to copy the 
configuration for one Marquee user to one or more other Marquee users.  
This operation covers virtual displays, display group membership, and 
display group messages. Performing this action removes any existing 
configuration for the target users, replacing it with the configuration for the 
user initially selected when this option is chosen. Note that: 

• a message sent to directly to the source user, not via a display group, will 
not be copied to the destination user(s) 

• messages sent to the channel on which the destination user is configured 
will remain with the destination user(s) 

• messages sent directly to the destination user(s) will remain with the 
destination user(s) 

• this feature is intended for use with Marquee users but also will work for 
TCP/IP Displays (including Encrypted TCP/IP Displays) 
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• Display Group – Provides options to create a new display group, modify 
an existing display group, rename a display group, or delete a display 
group. 

• Virtual Display – Provides options to define or delete a virtual display. 

• Launch Display Monitor - Launches the Display Monitor which allows 
you to see, on this pane, what messages are actually running.  Note that if the 
selected device OCM supports the display monitor application, and if a monitor 
port is configured, this item will launch the Display Monitor application and 
attach it to the selected display. 

• Properties - The Device ID, Serial Number, Type, Dimensions, Color, Inova 
LightLink Firmware Version, and Connection Status of the selected 
display(s) . 

Descriptions of the Display > Display Group sub-menu options: 

• New - Launches the display group Editor dialog for a new display 
group.  You must enter a valid display group name and its contents. 

• Modify - Only available if a single display group is selected.  Launches the 
display group Editor dialog for the selected display group. 

• Rename - Only available if a single display group is selected then allows 
editing of the display group name. 

• Delete - Only available if a single display group is selected then allows you 
to delete the selected display group. 

Descriptions of the Display > Virtual Display sub-menu options: 

• Define – Brings up the Define Virtual Display dialog, where one can define 
sub-regions of the display to which messages can be sent independently.  
This option is only enabled if one or more end-nodes in the Output Device 
Tree are selected (not for channels or display groups).  The selected devices 
must all support the same kind of virtual displays for this option to be 
enabled. 

• Delete – Deletes a virtual display.  This option is only enabled if one or 
more end-nodes in the Output Device Tree Control are selected (not for 
channels or display groups or end nodes that are not virtual displays).   

7.4. System Manager View Menu  

The following describes the System Manager View menu options.  

• Toolbar - Shows or hides the main window toolbar. 
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• Status Bar - Shows or hides the main window status bar. 

• Show/Hide Fast Text – This allows you to choose whether to display or 
hide the Fast Text editor pane. 

• Controlled Message Categories – [Optional] If any controlled message 
categories are configured and enable for System Manager's use, each will 
have a menu item in the View Menu above the Refresh Tree menu 
item.  The menu item will show or hide messages of the named category. 

• Refresh Tree - This causes the device tree to be reloaded. 
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7.5.  Tools Menu Commands  

The following describes the Tools menu options for System Manager. 

• Log Viewer - This option allows you to launch the Log Viewer to display 
diagnostic information. 

• Administrator - This option allows you to launch the Inova LightLink 
Administrator to make modifications to the system. 

• Import Messages - Allows you to open a dialog that allows you to load 
messages from a file and insert them into the LightLink System.  This 
option is available only if the user has the Import messages privilege set in 
Security Manager.  Refer to the Security Manager User Guide for more details.   

• Export Messages - Allows you to open a dialog that allows you to save 
messages stored in the Data Directory to a file.  This option is available only 
if the user has the Export messages privilege set in Security Manager.  Refer 
to the Security Manager User Guide for more details.   

• Migrate LLD – allows you to move files from one location to another.  Refer 
to the LightLink Migration Process Solution Guide for more details.   

7.6. Help Menu  

The following describes the Help menu options for System Manager. 

• System Manager Help - Opens the front page of the help file 

• Contents and Index - Opens the contents and index dialog for the help file 

• Icon Help - Opens a special help page which describes all the main 
window icons 

• Inova on the Web - Jump to the Inova Solutions web page if you have a 
web browser registered and internet access available 

• About System Manager - Opens the About Dialog for System Manager  
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8. Common Error Messages 

The most commonly encountered error messages in System Manager are: 

• Access Denied - Access is denied when your login ID or password is 
incorrect. If this occurs, log on again or see your System Administrator for 
additional assistance. 

• Could Not Send Command - This occurs when the network access to Inova 
Solutions LightLink is lost during a session.   

• Database Disconnect - Database Disconnect occurs if any of the shared 
database files cannot be found before or during a session.   

• Network Disconnect - This occurs when the network access to Inova 
Solutions LightLink is lost during a session.   

• No Connection - This occurs when you are unable to connect to Inova 
Solutions LightLink. This usually occurs when there is a configuration or 
network problem.  

• License Count Exceeded - The License Count Exceeded appears whenever 
the number of Supervisor Packs licensed for this system is exceeded.  

• Could Not Modify User - Occurs when the network access to Inova 
Solutions LightLink is lost during a System Manager session. This would be 
encountered when attempting to save window location and size properties 
for the next user session.  

• No Response from Server - Occurs when Inova Solutions LightLink does 
not respond to the request for detailed message properties.  

If any of the above problems continue or if any of the above reoccurs, then try 
again, try logging in again, or see your System Administrator for additional 
assistance. 

 

 


